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Lag et nytt EndNote-bibliotek

Nar du apner EndNote Desktop for fgrste gang, far du en gra skjerm med en menylinje pa toppen.

For & ta programmet i bruk, trenger du et bibliotek, som kan opprettes ved & klikke pa File > New. Gi

biblioteket et navn og klikk Save. Det nye biblioteket dpnes automatisk.

=  For a apne et eksisterende bibliotek, ga til File > Open Library... og finn frem biblioteket ditt.

= Et EndNote-bibliotek bestar alltid av en EndNote-fil med bibliotekets navn (f.eks. Endnote) og en
mappe med samme navn (Endnote.Data). De to delene ma alltid lagres sammen for at biblioteket
skal fungere problemfritt.

=  For a lagre en sikkerhetskopi av biblioteket i en komprimert fil: G til File > Compressed Library
(.enlx), og velg hva som skal veere med i biblioteket.
Klikk pa OK for a lagre filen pa gnsket sted.

Layout

Apner du et nytt bibliotek, vil skjermbildet se slik ut:

EndNote X9 File Edit References Groups Tools Window Help 0 = 100% B3 tor. 20. sep. 14:01:]
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Verktgylinje: Se lenger nede for beskrivelse av funksjoner

Referanseoversikt

Gruppepanel: Viser gruppene som biblioteket er inndelt i

Referansepanel: Visningsfelt for markert referanse

Visningsvalg for referansepanel: Referansedetaljer, forhandsvisning i henhold til valgt stil og

vedlegg (vanligvis fulltekst i PDF-format)

Layout: Velg posisjonering og utforming av referansepanelet

7. Kolonneoversikt for referanselisten: Kolonnene som vises kan endres med Ctrl-klikk, eller ved
a ga til EndNote X8 - Preferences - Display Fields

8. Valgmeny for referansestiler

9. Verktgylinje for Word-funksjoner
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Eksempel pa bibliotek i Bottom — Split layout:
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Synkronisering av biblioteket mot EndNote Online
Deling av biblioteket

Meldinger om nylige forandringer i biblioteket
Sgk etter fulltekst online

Finn oppdateringer for referansen

Legg til en ny referanse manuelt

Lokal modus
Online-modus
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Kopier referansen fra online-sgket til det lokale biblioteket
Sett inn markerte referanser i Word
Formater litteraturlisten
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Legg nye referanser til biblioteket

Det finnes flere mater a samle referanser i EndNote. Man kan eksportere referanser fra fagdatabaser
ved a laste ned en referansefil, man kan sgke i databaser via EndNote, eller man kan legge inn
referanser manuelt.

Eksporter referanser fra en database

For a eksportere referanser fra en fagdatabase, fglger du som regel disse stegene:

1) Sgk etter et emne i en relevant database

2) Kryss av for en eller flere aktuelle artikler i trefflisten

3) Klikk pa en knapp eller lenke med navnet cite, send to, download eller export.
4) Last ned referansene i EndNote- eller RIS-format.

5) Klikk pa filen i nedlastinger eller dra den til EndNote-ikonet for & importere

Ting kan ga galt under import av referansene. Opplysninger kan havne feil i felt, og de kan ogsa vaere
registrert feil. Du bgr derfor alltid korrekturlese referansene du har lastet inn.

Nedenfor finner du to eksempler for referanseeksport til EndNote fra Oria og Google Scholar.
Se hvordan du eksporterer referanser fra andre databaser pa bibliotekets EndNote hjelpesidene
(«Eksport av referanser fra databaser til EndNote Desktop»).

Eksport fra Oria:

1) Sgk opp referansen du vil overfgre
2) Klikk pa sitattegnet: **
3) Klikk pa EndNote Desktop

BOK
Vilt og fisk : jegerens og fiskerens kokebok
2002

Tilgjengeleg frd Hagskulen pa Vestlandet

-
” ] & & b B G 3
SITER E-POST SKRIV UT PERMANENT LE} RIS BIBTEX ENDNOTE ONLIN  ENDNOTE DESKI
Tegnsett (velg UTF-8)

DOWNLOAD

4) Klikk OKivinduet som apner seg (du trenger ikke a forandre innstillingene)
5) Lagre filen og/eller apne den med EndNote
6) Korrekturles den overfgrte referansen

=  For a redigere referansen, markerer du den i biblioteket for 3 apne den i referansepanelet.
Klikk deg inn i feltet som skal redigeres. Klikk pa File = Save (cmd+S) for & lagre endringene.



(%% ~) (Book <)

Author
Myhr, Eirik
Reuterstrand, Siri

Year
2002

Title
Vilt og fisk : jegerens og fiskerens kokebok

Series Title
Vilt & fiskkokboken

Place Published
Oslo

Publisher
Gyldendal

ISBN
8205307164

Keywords
Fisk
Skandinavia
kokebaker
matoppskrifter
vilt

= | eksempelbildet over star en referanse eksportert fra Oria til EndNote. | referansen kom
utgaveinformasjonen med pa norsk (utg.). | EndNote legger referansestilene automatisk til
utg. pa norsk eller ed. pa engelsk, og dette skal derfor ikke vaere med i referansen. | feltet
Edition skal det bare sta selve tallet. Feltet Series Title skal vaere tomt.

= For avelge om tomme felt skal vises i referansepanelet, klikk pa tannhjulsymbolet
i hjgrnet av referansepanelet og aktiver/deaktiver Show Empty Fields.

Eksport fra Google Scholar:

1) Sek opp referansen du @gnsker a overfgre
2) Klikk pa sitattegnet

ipoF] Ressurser av torsk og andre fisk i fjorder pa den norske Skagerrakkysten
J Gjesaster, K Enersen, SE Enersen - 1996 - brage bibsys.no

The abundance, distribution and life history parameters of cod, Gadus morhua L., and other
fish species were studied at the Norwegian Skagerrak Coast. 12 surveys were conducted in
the Sendeledfjord and the Sandnesfjord in the Riser area during the period March 1993 til1 __.

ko Sitert av 18 Beslektede artikler Find it @ HVL HTML-versjon <€
3) Idet nye vinduet, klikk pa EndNote
X Referanse

MLA  Gjesester, Jakob, Kate Enersen, and Svein Erik Enersen.
"Ressurser av torsk og andre fisk i fjorder pa den norske
Skagerrakkysten.” (1996).

APA Gjesaster, J., Enersen, K, & Enersen, S E. (1996). Ressurser
av torsk og andre fisk i fjorder pa den norske Skagerrakkysten.

IS0 690 GJESATER, Jakob; ENERSEN, Kate; ENERSEN, Svein Erik.

Ressurser av torsk og andre fisk i fjorder pa den norske
Skagerrakkysten. 1996

BibTeX RefMlan  RefiWorks ]



4) Lagre filen og/eller apne den i EndNote
5) Korrekturles den overfgrte referansen

Sek i fagdatabaser via EndNote (Online Search Mode)

| Online Search Mode kan du sgke etter referanser direkte i EndNote, uten at du ma apne databasen
i nettleseren din. En del sgkefunksjoner fra fagdatabasen vil mangle, sa Online Search Mode
anbefales bare for a sgke opp bestemte referanser, ikke for selve litteraturspket.

1) Bytt til Online Search Mode G

2) Velg databasen i sidepanelet som du vil sgke i (f.eks. PubMed, Web of Science, LOC)
Klikk pa@ more... om du ikke ser gnsket database i listen

3) Fyll ut et eller flere sgkefelt og klikk pa Search

4) Kopier referansene til biblioteket ved & markere dem i trefflisten og klikke pa

Copy to Local Library

= NB: Mange databaser krever palogging, og vil veere utilgjengelige for bruk.

Legg inn referanser manuelt
Referanser for bgker og tidsskriftsartikler kan du stort sett eksportere fra Oria eller fagdatabaser til

EndNote. For en del andre kilder er det ngdvendig a legge inn referansen manuelt, f.eks. nettsider,
avisartikler, lover og forskrifter, rapporter, retningslinjer eller bilde- og lydmateriale.

Ga til References - New Reference (cmd+N) eller klikk pa Ei

1)

2) Velg passende Reference Type og fyll ut de ngdvendige feltene
3) Lagre referansen ved a ga til File > Save (cmd+S)

4) Lukk referansen. Referansen finner du igjen under All References

For a finne passende Reference Type for kilden du bruker og for a sjekke hvilke felt som ma fylles ut,
kan du se pa eksempelsamlingene pa bibliotekets EndNote-hjelpesider.

Noen eksempler pa referanser som er lagt inn manuelt:

=  Lov

<

# v | (Legal Rule or Regulation

Author
Avhendingslova,

Year
1992

Title
Lov av 3. juli 1992 nr 93 om avhending av fast eiendom

URL
https://lovdata.no/dokument/NL/lov/1992-07-03-93




Nettside

# v | (Web Page )

Author
Helsedirektoratet,

Year
2017

Title
Nokkeltall: Spesialhelsetjenesten del 2

Place Published
Oslo

Publisher
Helsedirektoratet

Access Date
19. mai 2017

Last Update Date
23. februar 2017

URL
https:/helsedirektoratet.no/statistikk-og-analyse/nokkeltall/nokkeltall-for-
spesialisthelsetjenesten/nokkeltall-spesialisthelsetjenesten-del-2

Standard

¥ v | (standard

<>
2D

Institution
Standard Norge,

Year
2015

Title
Eurokode 3: Prosjektering av stélkonstruksjoner -
Del 1-1: Allmenne regler og regler for bygninger

Place Published
Oslo

Publisher
Standard Norge

Document Number
NS-EN 1993-1-1:2005+A1:2014+NA:2015

NB: Feltet Author fylles vanligvis fylles ut i formen:

Etternavn, Fornavn

Organisasjonsnavn som bestar av flere enn ett ord ma fgres inn med komma etter, for a8 unnga at
navnet inverteres som et personnavn. For eksempel:

Hggskulen pa Vestlandet,



EndNote og Word

Nar EndNote er installert, vil du finne en verktgylinje i Word med navn «EndNote X8». Denne bruker
du til a sette inn referanser fra biblioteket ditt, velge gnsket referansestil og til a tilpasse
referansehenvisningene i teksten.

Sett inn referanser

1) Sett markgren der du gnsker referansen, og klikk Insert Citation i EndNote-verktgylinjen

ik = (= Do
e e O g Oppse e gje 0 g EndNote X9
r| EN, Go to EndNot Styl APA 6th T I v
) < 4 ©0 fo Endlote YL # Categorize References v o0s -
Q E’,‘- Edit & Manage Citation(s) I @ Update Citations and Bibliography I ﬂ“ Manuscrlpt Matcher
Insert I Instant F ti Off v I Hel
Citation E‘n. Edit Library Reference(s) l @ Configure Bibliography I . b Tt :_- Preferences i

2) Sogk etter referansen du vil sette inn, f.eks. pa forfatter, ord i tittel eller arstall. Pass pa at du
spker i Libraries, ikke Shared Groups, nar du henter referanser fra eget bibliotek.

ONON | EndNote X9 Find & Insert My References
Find Citation: Q. Dalland 0] search: s
Author A | Year | Title

Dalland Metode og oppgaveskriving for student...

Reference Type: Book

Record Number: 2

Author: Dalland, Olav

Year: 2012

Title: Metode og oppgaveskriving for studenter
Series Title: Metode og oppgaveskriving

Place Published: Oslo

Publisher: Gyldendal akademisk

Edition: 5

ISBN: 9788205423985

®

Library: My EndNote Library.enl 1item in list

3) Med et klikk pa Insert setter du inn en henvisning i teksten, og referansen blir lagt til
i litteraturlisten pa slutten av dokumentet.

=  Huvis du bruker en forfatter-arstall-stil, kan du i nedtrekksmenyen av Insert velge om du
vil ha bade forfatter og arstall (Insert), L

bare arstall (Insert & Exclude Author) eller bare insert

forfatter (Insert & Exclude Year) med i teksten. Insert & Display as: Author (Year)
o . - . Insert & Exclude Author

Du kan ogsa bare legge til referansen i litteraturlisten iikarr & Ekoliide Yaas

Insert in Bibliography Only




(Insert in Bibliography Only), eller sette forfatteren utenfor parentes (Insert & Display
as: Author (Year)).
= Alternativ kan du bytte til EndNote Desktop, markere referansen(e) du vil sette inn, og

klikke symbolet E .

Velg referansestil og design av litteraturlisten

= Velg referansestil i stilmenyen.
= Klikk Select Another Style... for a finne installerte stiler som ikke er med i listen.

® o M & (= Dokument1

Hjem Sett inn Utforming Oppsett Referanser Masseutsendelser Se gjennom EndNote X9
r| EN, Go to EndNot Style: I APA 6th :I )
73 4 °0 10 EndRote o Ecn. Categorize References v
Q F?,'v Edit & Manage Citation(s) I @ Update Citations and Bibliography | l]ﬂ“' Manuscript Matcher

Insert I Instant Formatting is Off v Hel
Citation E&. Edit Library Reference(s) I Fj! Configure Bibliography l e E Preferences 2

= Du kan tilpasse font, skriftstgrrelse, innrykk, linjeavstand og avstand mellom
referansene i litteraturlisten under Blibliography = Configure Bibliography... > Layout

EndNote X8 Configure Bibliography

{ Format Bibliography [ Layout }

Font: [ Calibri ¢)  size 12 [v]

Bibliography title:

Start with bibliography number:

First line indent: |0.000 in Line spacing: [ Single 2]

Hanging indent: Space after: [ None C]
@ [ Cancel ] [ OK ]

Rediger og slett henvisninger

For a redigere referansene i et Word-dokument, bruker du funksjonen Edit & Manage Citation(s).
NB: Ikke skriv direkte inn i formaterte EndNote-felt! Det vil fgre til at endringene tilbakestilles
eller at formateringen gar tapt.

() o g 8 = kument1

Hjem Sett inn Utforming Oppsett Referanser Masseutsendelser Se gjennom EndNote X9
rl_ENGtEdNt Style: APA 6th o [— Tool
I | oo Fneoe o @ Categorize References v ools
Q |Z_?,|~ Edit & Manage Citation(s) II @ Update Citations and Bibliography l I.]L“'. Manuscript Matcher

Insert

Instant Formatting is Off VI Hel
Citation L-:',u, Edit Library Reference(s) I [F} Configure Bibliography I I g E Preferences B




= Det apnes ett nytt vindu med en oversiktsliste over referansene i dokumentet.

o e EndNote X8 Edit & Manage Citations
Citation ~ | Count | Library
¥ (Ciesielski, 1999)
Ciesielski, 1999 #21 1 Traveling Library
¥ (Ruer, 2013) Cc/D
Ruer, 2013 #22 i Traveling Library I
¥ (Myhre, Marshburn & Toverud, 1989, s. 48)
Myhre, 1989 #23@48 1 Traveling Library
¥ (Aalborg, 2015; Gjems-Onstad, 1984)
+ Gjems-Onstad, 1984 #... 1 Traveling Library
4+ Aalborg, 2015 #26 1 Traveling Library
¥ (Fischer, 2016; Mzeland, 2016)
L
{ Edit Citation = Reference }
| Format: [ Default 2] B
Prefix: I |
Suffix: | |
[Pages] A| |
@ @) [ cancel ] [ ok ]
Totals: 24 Citation Groups, 30 Citations, 30 References

A) Legg til sidetall

= | feltet Pages kan du legge inn sidetall for henvisningen i teksten. Dette gjelder for den
aktiverte henvisningen, og vil ikke pavirke andre instanser.

= Noen stiler stgtter ikke sidetall direkte, og da ma du legge det inn med Suffix istedenfor
Pages.
Pages = Skriv inn bare tallet
Suffix = Skriv inn «, s. sidetall»

= Klikk OK nar du er ferdig med redigering av referansen.

Eksempel:
F@r redigering: (Myhre, Marshburn & Toverud, 1989)
Etter redigering: (Myhre, Marshburn & Toverud, 1989, s. 48)

B) Fjern forfatternavn eller arstall fra henvisning in teksten

= Under Format kan du velge om du vil ha forfatter og arstall med
i referansehenvisningen.

Format: v Default
Display as: Author (Year)
Prefix: Exclude Author
Exclude Year
Suffix: Exclude Author & Year
Show Only in Bibliography

= Klikk OK nar du er ferdig med redigering av referansen.



C) Legg til en referanse pa samme sted som en eksisterende

= Klikk pa tannhjulet og velg Insert Citation.

¥ (Ruer, 2013)
Ruer, 2013 #22 1 Traveling Library (%% v)
¥ (Myhre, Marshburn & Toverud, 1989, s. 48) Edit Library Reference

. 3 Remove Citation
Myhre, 1989 #23@48 1 Traveling Library [
¥ (Aalborg, 2015; Gjems-Onstad, 1984) Update From My Library...

= Klikk OK nar du er ferdig med redigering av referansen.
D) Slette referanser

= Klikk pa tannhjulet og velg Remove Citation.

¥ (Ruer, 2013)
Ruer, 2013 #22 1 Traveling Library

¥ (Myhre, Marshburn & Toverud, 1989, s. 48) Wence
Myhre, 1989 #23@48 1 Traveling Library [ e

¥ (Aalborg, 2015; Gjems-Onstad, 1984) Update From My Library...

= Klikk OK nar du er ferdig med a redigere referansen.
= Henvisningen er na slettet fra dokumentet. Referansen ligger fremdeles i biblioteket.

Oppdatering, formatering og konvertering av referanser i Word
A) Oppdatere referanser

Nar du redigerer referanser i EndNote-biblioteket, ma de oppdateres i Word-dokumentet.

Dette gjgres automatisk innimellom, men kan gjgres manuelt ved a klikke pa Update

Citations and Bibliography.
o o N & e -

Hjem Sett inn Utforming Oppsett Referanser Masseutsendelser

EN, Go to EndNote Style: APA 6th S
|,, 1 4 4 @ Categori
Q lz_?,l- Edit & Manage Citation(s) | E} Update Citations and Bibliography
Insert Instant F

Citation E&, Edit Library Reference(s) I Ff} Configure Bibliography I

4

B) Avformatere referanser

Skal du flytte tekstavsnitt som inneholder EndNote-referanser eller sla sammen flere
dokumenter, bgr du avformatere referansene fgr du klipper og limer. Da vil Word arbeide
raskere. | sjeldne tilfeller kan kopiering av formaterte EndNote-referanser medfgre feil.

10



= Klikk pa Tools > Convert to Unformatted Citations

Hjem Sett inn Utforming Oppsett Referanser Masseutsendelser Se gjennom Visning EndNote X9
EN to EndNot Style: APA 6th = z Is ~
|,,| = | G SoitoiEndiicts vie [icn Categorize References '] LEELD n
Q @ Edit & Manage Citation(s) J lE} Update Citations and Bibliography ‘
Insert [ I F ing i v
Citation [E&, Edit Library Reference(s) ] @ Configure Bibliography] nstantronmatting s on

l l Convert to Unformatted Citations l

Convert to Plain Text

l Export Traveling Library

Dette fgrer til at litteraturlisten forsvinner, og henvisningene erstattes av EndNote-koder.

(Myhre, Marshburn & Toverud, 1989, s. 48) = {Mvyhre, 1989, Patologi@48}

Klikk pa Bibliography = Update Citations and Bibliography for a fa referansene tilbake til
formatert form.

C) Konverter referansene til tekst

Det er mulig a opprette et Word-dokument hvor forbindelsen til EndNote er brutt. Her kan
du gjgre siste finpuss i referansene. Dette burde vaere det siste man gjor fgr eventuell lagring
som PDF eller fgr man sender dokumentet fra seg.

NB: Ta vare pa det opprinnelige dokumentet, der EndNote-kodene er intakt. De kan ikke
gjenopprettes i det nye dokumentet.

= Klikk pa Tools = Convert to Plain Text

Hjem Sett inn Utforming Oppsett Referanser Masseutsendelser Se gjennom Visning EndNote X9
EN : [ﬁ 2 = v
I” he w s ABASIn é Categorize References ~ ke n
Q [—’r‘,l Edit & Manage Citation(s) l @ Update Citations and Bibliography ]
Insert — = — . —
Citation “:_.;:‘:. Edit Library Reference(s) ] ’E‘ Configure Bibliography I

— Convert to Unformatted Citations
{ Instant Formatting is On 'l
[ Convert to Plain Text ]

l Export Traveling Library

Organiser EndNote-biblioteket

Organiser biblioteket i grupper

Du kan holde orden i biblioteket ved a legge referansene i grupper.
= Custom groups:

For a lage en ny gruppe, ga til Groups = Create Group. Den nye gruppen finner du igjen under
My Groups i gruppepanelet. Du kan gi et navn til gruppen ved a klikke sakte pa den to ganger.
For a legge en referanse i gruppen, drar du referansen fra listen i All References til gruppen i
gruppepanelet.

=  Smart groups:

Smartgrupper samler referansene etter gitte kriterier. For a lage en ny smartgruppe, ga til
Groups = Create Smart group. Det dpnes et nytt vindu i det du kan velge et navn for gruppen og
sette kriterier for referansene. Du kan f.eks. sgke etter forfatter, arstall, opprettelsesdato,
database eller ngkkelord. Klikk Create for a opprette smartgruppen.
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Smart Group
Smart Group Name: iNew Smart Group
( Author Sl Contains C][ ]EJ
(and 3)( Year ) (_Contains __3)| (€3]S
(and 2)( Title 2)( Contains CJ[ ]@
(JJ Match Case (] Match Words

Slette dubletter

For @ unnga stgy fra referanser som er importert flere ganger, kan du sjekke biblioteket ditt for
dubletter. G4 til References - Find Duplicates. Finnes det dubletter i biblioteket ditt, apnes det et
vindu der du kan sammenligne dublettene. Velg referansen du vil beholde ved & klikke pa Keep This
Record.

Legg til fulltekst

Har du lagret fullteksten til en artikkel, kan du knytte den til referansen i EndNote-biblioteket ditt.
Legg ved en PDF ved 3 klikke pa den aktuelle referansen i EndNote og a klikke pa binders-symbolet i
referansepanelet.

(¢ ~] O s

There are no PDFs attached to this reference

Finn fulltekst pa nett

EndNote kan ogsa spke opp fulltekst pa nett. EndNote gjgr da et oppslag basert pa DOl og andre
opplysninger i referansen. Man kan ogsa gjgre oppslag i Oria, med OpenURL Link. Dette krever
registrering av HVLs OpenURL-server:

1) Gatil EndNote X8 - Preferences... 2 Find Full Text
2) |feltet OpenURL Path fgrer du inn:
http://openurl.bibsys.no/openurl

3) EZProxy-serveren settes inn i feltet Authenticate with: URL:
https://login.galanga.hvl.no/login?
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Change Case

EndNote™ Preferences

Display Fields The Find Full Text feature uses several technologies to maximize the
Display Fonts chances that EndNote will find all available PDFs. Use this screen to control
Duplicates these full text search options.
Eind:Eull TexF Web of Science Full Text Links
Folder Locations
Formatting DO (Digital Object Identifier)
Libgaries. PubMed LinkOut (U.S. National Library of Medicine)
PDF Handling
Read / Unread OpenURL
Reference Types
Sorting lopenurL Path: | |
Sync
Temporary Citations Authenticate with:
Term LlSt.S [URL: I II
URLs & Links
Examples: https://login.ezproxy.library.myuniversity.edu/login
http://auth.universityname.edu/authentication
Automatically invoke Find Full Text on newly-imported references
[ EndNote Defaults J [ Revert Panel ]
. . o e .
Marker referansene du gnsker fulltekst til, og klikk pa Find Full Text: Fullteksten som blir funnet

pa nett blir na lastet ned og knyttet til referansen i biblioteket. Referanser med fulltekst er merket
med binders-ikon.

Synkroniser biblioteket med EndNote Online

Du kan synkronisere EndNote-biblioteket med en online-konto via Sync funksjonen. Dette gjgr det
lettere 3 fa tilgang til biblioteket fra andre datamaskiner, og du kan jobbe med biblioteket hvor og
nar du vil, sa lenge du har tilgang til internett. Du kan enten opprette konto for EndNote Online

pa siden https://myendnoteweb.com, eller ved 3 klikke pa Sync C Om du setter opp andre
datamaskiner til 3 synkronisere mot den samme kontoen, vil de kunne benytte samme bibliotek.
Biblioteket er ogsa tilgjengelig i EndNote Online.

For mer informasjon om EndNote Online, se «kKom i gang med Endnote Online» pa bibliotekets
EndNote-hjelpesider.

Del biblioteket

| EndNote Desktop kan du dele et helt bibliotek, og kun ett. Klikk File = Share (eller Share Library

k). Om du ikke har satt opp synkronisering, tar EndNote deg f@rst giennom denne prosessen. For 3
dele biblioteket, fgrer du inn epost-adressene for samarbeidspartnerne i det midterste feltet i
Sharing-vinduet (Invite More People). Klikk Invite, sa blir det sendt delingsinvitasjoner pa epost.
Mottakerne far en lenke til EndNote Online, og etter a ha logget seg inn, vil de finne igjen det delte
biblioteket i EndNote under File = Open Shared Library..., forutsatt at EndNote er synkronisert til
den samme kontoen.
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Om du ikke finner gnsket referansestil i EndNote stilsamlingen

Last ned referansestiler

Det finnes en rekke forskjellige stiler til nedlasting pa EndNotes nettsider. HVL har et mindre utvalg

pa norsk.

Har du lastet ned en referansestil fra nett, installerer du ved a apne filen, og deretter lagre den: File

- Save As... Velg et navn for stilen og klikk Save.

Se lenkene under «Referansestiler» pa bibliotekets EndNote-hjelpesider for referansestiler tilpasset

for HVL.

Redigering av eksisterende referansestiler

Vil du tilpasse en referansestil, f.eks. endre forkortelser, er det enklest & redigere en eksisterende stil.

1) Ga til Edit = Output Styles > Open Style Manager...

| oversiktslisten av stiler kan du krysse av stilene som vises i stilmenyen i EndNote og Word.

2) Marker stilen du gnsker a redigere og klikk Edit
3) Tilpass det du gnsker og avslutt med File - Save As...

Noen vanlige redigeringsmuligheter:

= Velg om tidsskrifttittel skal forkortes:
Journal Names
= Bytte ut engelske mot norske forkortelser i referansehenvisning:
Citations - Author Lists
=  Bytte ut engelske mot norske forkortelser for sidetall:
Citations > Templates: erstatt «p.» med «s.»
Bibliography - Templates: erstatt «p.» med «s.»

= Det meste av stilen er definert under Bibliography - Templates. Her er det definert hvilke
EndNote-felt som skal vises for de forskjellige referansetypene i litteraturlisten. Skal du

redigere noe her, bgr du veere veldig ngyaktig med tegnsettingen for a fa en feilfri
referansestil! For a legge til et nytt felt, klikk pa Insert Field og velg aktuell felt.
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Andre nyttige funksjoner i EndNote

Quick Search

Du kan bruke funksjonen «Quick Search» for a finne fort frem til en bestemt referanse i biblioteket.

EB [ Q_ Search Library

PDF-redigering

Det er mulig redigere PDF-filer knyttet til referanser i EndNote, f.eks. markere eller understreke
tekstpassasjer, legge til notater, etc.

Tittelregister for tidsskrifter

Noen databaser eksporterer referanser med forkortet tidsskrifttittel, og noen referansestiler krever
full tittel — og omvendt. EndNote kan oversette mellom kort og fullstendig tittel, og kommer med
ferdige tittelregistre for ulike fagomrader:

1) Gatil Tools 2 Open Term Lists 2 Journal Term List

2) Marker alle termer i listen og klikk pa Delete Term

3) Bytt til fanen Lists og klikk pa Import List...

4) Velg en aktuell liste (bare én) og klikk Choose for a importere listen

= Skulle du ikke automatisk komme til EndNotes termliste nar du klikker pa Import List...,
sa finner du listen under Applications > EndNote - Terms

Importer referanser fra PDF

EndNote har en funksjon for a importere referanser basert pa fulltekstartikler i PDF-format. Dette vil
som regel bare fungere for nyere PDF-er med DOI.

= |mport av en enkelt PDF-fil:

1) Gatil File > Import...

2) Under Options og Import Options, velg PDF File or Folder
3) Finn frem mappen eller PDF-filen du vil importere

4) Klikk pa Import
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